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Product notice

This guide describes features that are
common to most models. Some features
may not be available on your computer.

Not all features are available in all editions
of Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers and/or software to take
full advantage of Windows 8 functionality.
See http://www.microsoft.comfor details.

To obtain the latest information in this
guide, contact support. For U.S. support, go
to http://www.hp.com/go/contactHP. For
worldwide support, go to
http://welcome.hp.com/country/us/en/
wwcontact_us.html.

Software terms

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to
be bound by the terms of the HP End User
License Agreement (EULA). If you do not
accept these license terms, your sole
remedy is to return the entire unused
product (hardware and software) within 14
days for a refund subject to the refund
policy of your place of purchase.

For any further information or to request a
full refund of the computer, please contact
your local point of sale (the seller).


http://www.microsoft.com
http://www.hp.com/go/contactHP
http://welcome.hp.com/country/us/en/wwcontact_us.html
http://welcome.hp.com/country/us/en/wwcontact_us.html

Safety warning notice

AWARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Welcome

After you set up and register the computer, it is important to take the following steps:

Take a minute to browse the printed Windows 8 Basics guide to explore the new Windows®
features.

;@:_ TIP: To quickly return to the computer Start screen from an open app or the Windows desktop,

press the Windows button == on your keyboard. Pressing the Windows button again will

return you to the previous screen.

Connect to the Internet—Set up your wired or wireless network so that you can connect to the
Internet. For more information, see Connecting to a network on page 14.

Update your antivirus software—Protect your computer from damage caused by viruses. The
software is preinstalled on the computer. For more information, see Using antivirus software

on page 64.

Get to know your computer—Learn about your computer features. Refer to Getting to know
your computer on page 4 and Navigating using the keyboard, touch gestures and pointing
devices on page 19 for additional information.

Find installed software—Access a list of the software preinstalled on the computer:

From the Start screen, type a, click Apps, and then select from the displayed options. For
details about using the software included with the computer, see the software manufacturer's
instructions, which may be provided with the software or on the manufacturer's website.

Back up your hard drive by creating recovery discs or a recovery flash drive. See Backup and
recovery on page 72.
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Finding information

The computer comes with several resources to help you perform various tasks.

Resources

For information about

Setup Instructions poster

How to set up the computer

Help to identify computer components

Windows 8 Basics guide

Overview of using and navigating with Windows® 8.

HP Support Assistant

To access HP Support Assistant on the Start screen,
select the HP Support Assistant app.

To obtain the latest information in this guide, contact
support. For U.S. support, go to http://www.hp.com/go/
contactHP. For worldwide support, go to
http://welcome.hp.com/country/us/en/

wwcontact _us.html.

Operating system information
Software, driver, and BIOS updates
Troubleshooting tools

How to access support

Regulatory, Safety, and Environmental Notices

To access the user guides, select the HP Support
Assistant app on the Start screen, select My
computer, and then select User guides.

Regulatory and safety information

Battery disposal information

Safety & Comfort Guide

To access the user guides, select the HP Support
Assistant app on the Start screen, select My
computer, and then select User guides.

—or—

Go to http://www.hp.com/ergo.

Proper workstation setup, posture, health, and work habits

Electrical and mechanical safety information

Worldwide Telephone Numbers booklet

This booklet is provided with your computer.

HP support telephone numbers

HP website

To obtain the latest information in this guide, contact
support. For U.S. support, go to http://www.hp.com/go/
contactHP. For worldwide support, go to
http://welcome.hp.com/country/us/en/
wwcontact_us.html.

Support information
Ordering parts and finding additional help

Accessories available for the device

Chapter 1 Welcome
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Resources For information about

Limited Warranty* Warranty information
To access this guide, from the Start screen, select the

HP Support Assistant app, select My computer, and

then select Warranty and services.

—or—

Go to http://www.hp.com/go/orderdocuments.

*You can find the expressly provided HP Limited Warranty applicable to your product located with the user guides on your
computer and/or on the CD/DVD provided in the box. In some countries/regions, HP may provide a printed HP Limited
Warranty in the box. For some countries/regions where the warranty is not provided in printed format, you may request a
printed copy from http://www.hp.com/go/orderdocuments or write to:

° North America: Hewlett-Packard, MS POD, 11311 Chinden Blvd., Boise, ID 83714, USA
o  Europe, Middle East, Africa: Hewlett-Packard, POD, Via G. Di Vittorio, 9, 20063, Cernusco s/Naviglio (Ml), Italy
e  Asia Pacific: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507

When you request a printed copy of your warranty, please include your product number, warranty period (found on your
service label), name, and postal address.

IMPORTANT: Do NOT return your HP product to the addresses above. For U.S. support, go to http://www.hp.com/go/
contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact us.html.

Finding information 3


http://www.hp.com/go/orderdocuments
http://www.hp.com/go/orderdocuments
http://www.hp.com/go/contactHP
http://www.hp.com/go/contactHP
http://welcome.hp.com/country/us/en/wwcontact_us.html

2 Getting to know your computer

Top
TouchPad

|

|

| |[é]L\|_“

B

Component

Description

0

Pointing stick

Moves the pointer and selects or activates items on the
screen.

(2

Left pointing stick button

Functions like the left button on an external mouse.

(3)

TouchPad on/off button

Turns the TouchPad on and off.

4

TouchPad zone

Moves the pointer and selects or activates items on the
screen.

(%)

Left TouchPad button

Functions like the left button on an external mouse.

(6)

Right pointing stick button

Functions like the right button on an external mouse.

M

Right TouchPad button

Functions like the right button on an external mouse.

4  Chapter 2 Getting to know your computer



Lights
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Component Description

(1) EI] Power light e On: The computer is on.

e  Blinking: The computer is in the Sleep state.

e  Off: The computer is off or in Hibernation.

(2) Caps lock light On: Caps lock is on.
(3) |:I¢|ﬂ Microphone mute light On: Microphone is muted.
(4) Num lock light On: Num lock is on.
(5) {‘ :} Wireless light e  White: An integrated wireless device, such as a
I wireless local area network (WLAN) device, is on.

e  Amber: All wireless devices are off.

(6) ‘ ﬂ Mute light e  Amber: Computer sound is off.

e  Off: Computer sound is on.

Top
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Buttons and fingerprint reader (select models only)

— | | | P
=
| I |
Component Description
(1) I Power button e  When the computer is off, press the button to turn on
U the computer.
e  When the computer is on, press the button briefly to
initiate Sleep.
e  When the computer is in the Sleep state, press the
button briefly to exit Sleep.
e  When the computer is in Hibernation, press the button
briefly to exit Hibernation.
If the computer has stopped responding and Microsoft®
Windows® shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off the
computer.
To learn more about your power settings:
e  Select Start > Control Panel > System and
Security > Power Options.
e  For more information, see the HP Notebook Reference
Guide.
(2) Speakers (2) Produce sound.
(3) {: :} Wireless button Turns the wireless feature on or off but does not establish a
I wireless connection.

Chapter 2 Getting to know your computer



Keys

Component

Description

(4)

L[]

Volume mute button

Mutes and restores speaker sound.

()

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a
password logon.

OB ®OOHBE

Component

Description

()

esc key

Displays system information when pressed in combination
with the fn key.

)

fn key

Executes frequently used system functions when pressed
in combination with a function key, the num Ik key, the esc
key, or other keys. For more information, see Navigating
using the keyboard, touch gestures and pointing devices
on page 19.

(&)

Windows logo key

Displays the Windows Start menu.

(4)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key. For more information, see
Navigating using the keyboard, touch gestures and pointing

devices on page 19.

()

Embedded numeric keypad

When the keypad is turned on, it can be used like an
external numeric keypad.

Each key on the keypad performs the function indicated by
the icon in the upper-right corner of the key.

(6)

num |k key

Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.

Alternates between the navigational and numeric functions
on the integrated numeric keypad.

Top
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Front

DO®ES

22

-
= :
=i . I

Component Description

(1) {: I :} Wireless light The wireless connection is on.

(2) LI) Power light e  On: The computer is on.

e  Blinking: The computer is in the Sleep state.

e  Off: The computer is off or in Hibernation.

3) AC adapter/Battery light e  Amber: The computer is connected to external
power and the battery is charged from 0 to 90
percent.

e  White: The computer is connected to external
power and the battery is charged from 90 to 99
percent.

e  Blinking amber: A battery that is the only
available power source has reached a low
battery level. When the battery reaches a critical
battery level, the battery light begins blinking
rapidly.

e  Off: The battery is fully charged.

(4) - Hard drive light e  Blinking white: The hard drive is being accessed.

-
— e  Amber: HP 3D DriveGuard has temporarily

parked the hard drive.

NOTE: For information on HP 3D DriveGuard,
see the HP Notebook Reference Guide.

Chapter 2 Getting to know your computer



Component Description

(1) Audio-out (headphone) jack/Audio-in Produces sound when connected to optional powered
n (microphone) jack stereo speakers, headphones, earbuds, a headset, or
- television audio. Also connects an optional headset
microphone.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, see the
Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and
audio-in (microphone).

(2) +B DisplayPort Connects an optional digital display device, such as a high-
performance monitor or projector.

(3) USB 3.0 ports (2) Connect optional USB 3.0 devices and provide enhanced

S5 USB power performance.

(4) Memory card reader Reads data from and writes data to memory cards such as
Secure Digital (SD).

(5) RJ-45 (network) jack Connects a network cable.

(6) Docking port Connects an optional docking device.

(7) | i Power connector Connects an AC adapter.
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Component Description

0

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

)

Vents, 2

Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3)

(]

External VGA monitor port

Connects an external VGA monitor or projector.

4

USB 3.0 charging port

Connects an optional USB device. The USB charging port
can also charge select models of cell phones and MP3
players, even when the computer is off.

NOTE: A USB charging port (also referred to as a
powered USB port) allows you to charge connected USB
devices. Standard USB ports will not charge all USB
devices or will charge using a low current. Some USB
devices require power and require you to use a powered
port.

(5

Smart card reader

Supports optional smart cards.
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Component

Description

()

WLAN antennas (2)*

Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

NOTE: To setup a WLAN and connect to the Internet, you
need a broadband modem (either DSL or cable) (purchased
separately), high-speed Internet service, purchased from an
Internet service provider, and a wireless router (purchased
separately).

()

WWAN antennas (2)*

Send and receive wireless signals to communicate with wireless
wide area networks (WWAN).

(&)

Internal microphones (2)

Record sound.

(4)

Webcam light (select models only)

On: The webcam is in use.

®)

Webcam (select models only)

Records video and captures still photographs.

To use the webcam, select Start > All Programs >
Communication and Chat > HP Webcam.

(6)

Internal display switch

Turns off the display or initiates Sleep if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Display
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Bottom
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Component Description
(1) Service door Provides access to the hard drive bay, the

wireless LAN (WLAN) module slot, the WWAN
module slot, and the memory module slots.

CAUTION: To prevent an unresponsive
system, replace the wireless module only with
a wireless module authorized for use in the
computer by the governmental agency that
regulates wireless devices in your country or
region. If you replace the module and then
receive a warning message, remove the
module to restore computer functionality, and
then contact support through Help and
Support.
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Component

Description

() E <
H*
a

Service door release lock

Releases the service door from the computer.
A security screw is available to prevent the
service door from being accidentally removed.

@)

Vents (2)

Enable airflow to cool internal components.

NOTE: The computer fan starts up
automatically to cool internal components and
prevent overheating. It is normal for the

internal fan to cycle on and off during routine
operation.

Bottom 13



3 Connecting to a network

Your computer can travel with you wherever you go. But even at home, you can explore the globe
and access information from millions of websites using your computer and a wired or wireless
network connection. This chapter will help you get connected to that world.

Connecting to a wireless network

Wireless technology transfers data across radio waves instead of wires. Your computer may be
equipped with one or more of the following wireless devices:

e  Wireless local area network (WLAN) device—Connects the computer to wireless local area
networks (commonly referred to as Wi-Fi networks, wireless LANs, or WLANS) in corporate
offices, your home, and public places such as airports, restaurants, coffee shops, hotels, and
universities. In a WLAN, the mobile wireless device in your computer communicates with a
wireless router or a wireless access point.

e HP Mobile Broadband Module (select models only)—A wireless wide area network (WWAN)
device that gives you wireless connectivity over a much larger area. Mobile network operators
install base stations (similar to cell phone towers) throughout large geographic areas, effectively
providing coverage across entire states, regions, or even countries.

For more information about wireless technology, see the information and website links provided in HP

Support Assistant. To access HP Support Assistant on the Start screen, select the HP Support
Assistant app.

Using the wireless controls
You can control the wireless devices in your computer using these features:

e  Wireless button, wireless switch, or wireless key (referred to in this chapter as the wireless
button)

e  Operating system controls

Using the wireless button

The computer has a wireless button, one or more wireless devices, and one or two wireless lights,
depending on the model. All of the wireless devices on your computer are enabled at the factory, so
the wireless light is on (white) when you turn on the computer.

The wireless light indicates the overall power state of your wireless devices, not the status of
individual devices. If the wireless light is white, at least one wireless device is on. If the wireless light
is off, all wireless devices are off.
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E‘%NOTE: On some models, the wireless light is amber when all wireless devices are off.

Because the wireless devices are enabled at the factory, you can use the wireless button to turn on or
turn off the wireless devices simultaneously.

Using operating system controls

The Network and Sharing Center allows you to set up a connection or network, connect to a network,
manage wireless networks, and diagnose and repair network problems.

To use operating system controls:
1. From the Start screen, type n, and then select Settings..

2. Type network and sharing in the search box, and then select Network and Sharing
Center.

For more information, access HP Support Assistant. To access HP Support Assistant on the Start
screen, select the HP Support Assistant app.

Using a WLAN

With a WLAN device, you can access a wireless local area network (WLAN), which is composed of
other computers and accessories that are linked by a wireless router or a wireless access point.

E%?NOTE: The terms wireless router and wireless access point are often used interchangeably.

e Alarge-scale WLAN, such as a corporate or public WLAN, typically uses wireless access points
that can accommodate a large number of computers and accessories and can separate critical
network functions.

e A home or small office WLAN typically uses a wireless router, which allows several wireless and
wired computers to share an Internet connection, a printer, and files without requiring additional
pieces of hardware or software.

To use the WLAN device in your computer, you must connect to a WLAN infrastructure (provided
through a service provider or a public or corporate network).

Using an Internet service provider

When you are setting up Internet access in your home, you must establish an account with an
Internet service provider (ISP). To purchase Internet service and a modem, contact a local ISP. The
ISP will help set up the modem, install a network cable to connect your wireless computer to the
modem, and test the Internet service.

=7 NOTE: Your ISP will give you a user ID and a password to use for Internet access. Record this
information and store it in a safe place.
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Setting up a WLAN
To set up a WLAN and connect to the Internet, you need the following equipment:

e A broadband modem (either DSL or cable) (1) and high-speed Internet service purchased from
an Internet service provider

e A wireless router (2) (purchased separately)

e A wireless computer (3)

@NOTE: Some modems have a built-in wireless router. Check with your ISP to determine what type
of modem you have.

The illustration below shows an example of a wireless network installation that is connected to the
Internet.

©

As your network grows, additional wireless and wired computers can be connected to the network to

access the Internet.

For help in setting up your WLAN, see the information provided by your router manufacturer or your
ISP.

Configuring a wireless router

For help in setting up a WLAN, see the information provided by your router manufacturer or your ISP.

@NOTE: It is recommended that you initially connect your new wireless computer to the router by
using the network cable provided with the router. When the computer successfully connects to the
Internet, disconnect the cable, and access the Internet through your wireless network.

Protecting your WLAN

When you set up a WLAN or access an existing WLAN, always enable security features to protect
your network from unauthorized access. WLANS in public areas (hotspots) like coffee shops and
airports may not provide any security. If you are concerned about the security of your computer in a
hotspot, limit your network activities to email that is not confidential and basic Internet surfing.

Wireless radio signals travel outside the network, so other WLAN devices can pick up unprotected
signals. Take the following precautions to protect your WLAN:

° Use a firewall.

A firewall checks both data and requests for data that are sent to your network, and discards any
suspicious items. Firewalls are available in both software and hardware. Some networks use a
combination of both types.

e  Use wireless encryption.
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Wireless encryption uses security settings to encrypt and decrypt data that is transmitted over
the network. For more information, access HP Support Assistant. To access HP Support
Assistant on the Start screen, select the HP Support Assistant app.

Connecting to a WLAN

To connect to the WLAN, follow these steps:

1. Be sure that the WLAN device is on. If the device is on, the wireless light is on. If the wireless
light is off, press the wireless button.

@’NOTE: On some models, the wireless light is amber when all wireless devices are off.

2.  From the Windows desktop, click the network status icon in the notification area, at the far right
of the taskbar.

3. Select your WLAN from the list.

4. Click Connect.

If the WLAN is a security-enabled WLAN, you are prompted to enter a security code. Type the
code, and then click Next.

¢ NOTE: If no WLANSs are listed, you may be out of range of a wireless router or access point.

=¥ NOTE: If you do not see the WLAN you want to connect to, from the Windows desktop, right-
click the network status icon, and then select Open Network and Sharing Center. Click Set up
a new connection or network. A list of options is displayed, allowing you to manually search
for and connect to a network or to create a new network connection.

5. Follow the on-screen instructions to complete the connection.

After the connection is made, place the mouse pointer over the network status icon in the notification
area, at the far right of the taskbar, to verify the name and status of the connection.

E’%NOTE: The functional range (how far your wireless signals travel) depends on WLAN
implementation, router manufacturer, and interference from other electronic devices or structural

barriers such as walls and floors.

Using GPS

Your computer may be equipped with a Global Positioning System (GPS) device. GPS satellites
deliver location, speed, and direction information to GPS-equipped systems.

For more information, see the HP GPS and Location software Help.

Connecting to a wireless network
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Connecting to a wired network

There are 2 kinds of wired connections: local area network (LAN) and modem connection. A LAN
connection uses a network cable and is much faster than a modem, which uses a telephone cable.
Both cables are sold separately.

AWARNING! To reduce the risk of electric shock, fire, or damage to the equipment, do not plug a
modem cable or telephone cable into an RJ-45 (network) jack.

Connecting to a local area network (LAN)

Use a LAN connection if you want to connect the computer directly to a router in your home (instead
of working wirelessly), or if you want to connect to an existing network at your office.

Connecting to a LAN requires an 8-pin, RJ-45 network cable.
To connect the network cable, follow these steps:
1. Plug the network cable into the network jack (1) on the computer.

2. Plug the other end of the network cable into a network wall jack (2) or router.

E%?NOTE: If the network cable contains noise suppression circuitry (3), which prevents
interference from TV and radio reception, orient the circuitry end of the cable toward the
computer.

T

o —

of.
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4 Navigating using the keyboard, touch
gestures and pointing devices

Your computer allows navigation using touch gestures (select models only) in addition to the
keyboard and mouse. Touch gestures can be used on your computer TouchPad or on a touch screen
(select models only).

Review the Windows 8 Basics guide included with your computer. The guide provides information on
common tasks using the TouchPad, touch screen, or the keyboard.

Select computer models have special action keys or hot key functions on the keyboard to perform
routine tasks.

Using pointing devices

E/i"NOTE: In addition to the pointing devices included with your computer, you can use an external
USB mouse (purchased separately) by connecting it to one of the USB ports on the computer.

Setting pointing device preferences

Use Mouse Properties in Windows to customize settings for pointing devices, such as button
configuration, click speed, and pointer options.

To access Mouse Properties:

e From the Start screen, type mouse, click Settings, and then select Mouse.

Using the pointing stick

Press the pointing stick in the direction you want to move the pointer on the screen. Use the left and
right pointing stick buttons as you would the left and right buttons on an external mouse.

Using the TouchPad

To move the pointer, slide one finger across the TouchPad in the direction you want the pointer to go.
Use the left and right TouchPad buttons like the buttons on an external mouse.

Turning the TouchPad off and on
To turn the TouchPad off and on, quickly double-tap the TouchPad on/off button.
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Using TouchPad Gestures

Your TouchPad or touch screen (select models only) allows you to navigate the pointing device on
the screen by using your fingers to control the pointer action.

:@: TIP: For touch screen computers, you may perform the gestures on the display, on the TouchPad or
"*" a combination of the two.

The TouchPad supports a variety of gestures. To use TouchPad gestures, place two fingers on the
TouchPad at the same time.

@NOTE: TouchPad gestures are not supported in all programs.

1.

3.

From the Start screen type mouse, click Settings, and then select Mouse from the list of
applications.

Click the Device Settings tab, select the device in the window that is displayed, and then click
Settings.

Click a gesture to activate the demonstration.

To turn the gestures off or on:

1.
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From the Start screen type mouse, click Settings, and then select Mouse from the list of
applications.

Click the Device Settings tab, select the device in the window that is displayed, and then click
Settings.

Select the check box next to the gesture that you want to turn off or on.

Click Apply, and then click OK.
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One-finger slide
The one-finger slide lets you navigate around the screen.

e  Place your finger on the TouchPad zone and slide your finger to move the on-screen pointer in
the direction you want the pointer to go.

Tapping
To make an on-screen selection, use the Tap function on the TouchPad.

e Tap one finger on the TouchPad zone to make a selection. Double-tap an item to open it.
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Scrolling
Scrolling is useful for moving up, down, or sideways on a page or image.

e  Place two fingers slightly apart on the TouchPad zone and then drag them up, down, left, or
right.

Pinching/zooming
Pinching and zooming allow you to zoom out or in on images or text.

e Zoom in by placing two fingers together on the TouchPad zone and then moving your fingers
apart.

e Zoom out by placing two fingers apart on the TouchPad zone and then moving your fingers

together.
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Edge swipes (select models only)

Edge swipes allow you to access toolbars on your computer for tasks such as changing settings and
finding or using apps. This capability may be available on your computer, but you may have to enable
it through a Windows setting.

Right-edge swipe

The right-edge swipe accesses the charms, which let you Search, Share, start apps, access Devices,
or change Settings.

e  Swipe your finger gently from the right edge to display the charms.

Top-edge swipe

The top-edge swipe allows you to open apps available from the start screen.

)94y

MIMPORTANT: When an app is active, the top-edge gesture varies depending on the app.

e  Swipe your finger gently from the top edge to display available apps.
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Left-edge swipe

The left-edge swipe accesses your recently opened apps so that you can switch between them
quickly.

Swipe your finger gently from the left edge of the TouchPad to switch between recently opened apps.

e  Swipe from the left edge of the TouchPad to switch between apps.
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Using the keyboard

The keyboard and mouse allow you to type select items, scroll and to perform the same functions as
using touch gestures. The keyboard also allows you to use action keys and hot keys to perform
specific functions .

'Q‘ TIP: The Windows key == on the keyboard allows you to quickly return to the Start screen from

an open app or the Windows desktop. Pressing the Windows button again will return you to the
previous screen.

“»NOTE: Depending on the country or region, your keyboard may have different keys and keyboard
functions than those discussed in this section.

Using Microsoft Windows 8 shortcut keys

Microsoft Windows 8 provides shortcuts to perform actions quickly. Several shortcuts will help you

with Windows 8 functions. Press the Windows button == in combination with the key to perform the

action.

For additional information on Windows 8 shortcut keys go to HP Support Assistant. To access HP
Support Assistant on the Start screen, select the HP Support Assistant app.

Shortcut Key Description
key
il Opens the Start screen.
Ll |
an + c Opens the charms.
Ll |
an + d Opens the Windows desktop.
Ll |
an + tab Switches between open apps.
Ll |
NOTE: Continue to press this key combination until the app you
want opens.
alt + 4 Closes an active app.

Identifying the hot keys
A hot key is a combination of the fn key and either the esc key or one of the function keys.
To use a hot key:

A Briefly press the fn key, and then briefly press the second key of the hot key combination.

Hot key Description
combination

fn+esc Displays system information.
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Hot key
combination

Description

‘ fn+f3

Initiates Sleep, which saves your information in system memory. The display and other system
components turn off and power is conserved.

To exit Sleep, briefly press the power button.
CAUTION: To reduce the risk of information loss, save your work before initiating Sleep.

NOTE: If a critical battery level occurs while the computer is in the Sleep state, the computer
initiates Hibernation and the information stored in system memory is saved to the hard drive.

The function of the fn+f3 hot key can be changed. For example, you can set the fn+f3 hot key to
initiate Hibernation instead of Sleep. In all Windows operating system windows, references to the
sleep button apply to the fn+f3 hot key.

fn+f4
i -

Switches the screen image among display devices connected to the system. For example, if a
monitor is connected to the computer, fn+f4 alternates the screen image from computer display to
monitor display to simultaneous display on both the computer and the monitor.

Most external monitors receive video information from the computer using the external VGA video
standard. The fn+f4 hot key can also alternate images among other devices that are receiving video
information from the computer.

fn+ 6
o

Decreases speaker volume.

‘Ill fn+f7

Increases speaker volume.

fn+f8

Microphone on/off.

§ fn+f9

Decreases the screen brightness level.

i fn+f10

Increases the screen brightness level.

fn+f11

Turns the keyboard backlight on and off.

NOTE: The keyboard backlight is turned on at the factory. To extend battery life, turn off the
keyboard backlight.

Using keypads

The computer includes an embedded numeric keypad. The computer also supports an optional
external numeric keypad, or an optional external keyboard that includes a numeric keypad.
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Using the embedded numeric keypad

Component Description

(1) fn key Turns the embedded numeric keypad on and off when pressed
in combination with the num Ik key.

NOTE: The embedded numeric keypad will not function while
an external keyboard or numeric keypad is connected to the
computer.

(2) Embedded numeric keypad When the keypad is turned on, it can be used like an external
numeric keypad.

Each key on the keypad performs the function indicated by the
icon in the upper-right corner of the key.

(3) num |k key Turns the embedded numeric keypad on and off when pressed
in combination with the fn key.

NOTE: The keypad function that is active when the computer is
turned off is reinstated when the computer is turned back on.
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Turning the embedded numeric keypad on and off

Press fn+num Ik to turn on the embedded numeric keypad. Press fn+num Ik again to turn off the
keypad.

=2 NOTE: The embedded numeric keypad is turned off while an external keyboard or numeric keypad
is connected to the computer.

Switching key functions on the embedded numeric keypad

You can temporarily alternate the functions of keys on the embedded numeric keypad between their
standard keyboard functions and their keypad functions:

e To use the navigational function of a keypad key while the keypad is off, press and hold the fn
key while pressing the keypad key.

e To use the standard function of a keypad key while the keypad is on:
° Press and hold the fn key to type in lowercase.

° Press and hold fn+shift to type in uppercase.

Using an optional external numeric keypad

Keys on most external numeric keypads function differently according to whether num lock is on or
off. (Num lock is turned off at the factory.) For example:

e  When num lock is on, most keypad keys type numbers.
e  When num lock is off, most keypad keys function like the arrow, page up, or page down keys.

When num lock on an external keypad is turned on, the num lock light on the computer is turned on.
When num lock on an external keypad is turned off, the num lock light on the computer is turned off.

To turn num lock on or off on an external keypad as you work:

A Press the num Ik key on the external keypad, not on the computer.
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5 Multimedia

Your computer may include the following:
e Integrated speaker(s)

e Integrated microphone(s)

e Integrated webcam

e Preinstalled multimedia software

e  Multimedia buttons or keys

Using the media activity controls

Depending on your computer model, you may have the following media activity controls that allow
you to play, pause, fast forward, or rewind a media file:

e Media buttons
e Media hot keys (specific keys pressed in combination with the fn key)

e Media keys

Audio

On your HP computer, you can play music CDs, download and listen to music, stream audio content
from the web (including radio), record audio, or mix audio and video to create multimedia. To
enhance your listening enjoyment, attach external audio devices such as speakers or headphones.

Connecting speakers

You can attach wired speakers to your computer by connecting them to a USB port (or the audio-out
jack) on your computer or on a docking station.

To connect wireless speakers to your computer, follow the device manufacturer's instructions. Before
connecting audio devices, be sure to adjust the volume.
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Adjusting the volume
Depending on your computer model, you can adjust the volume using the following:
e  Volume buttons
e Volume hot keys (specific keys pressed in combination with the fn key)

e Volume keys

/\ WARNING! To reduce the risk of personal injury, adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information, see the Regulatory, Safety and
Environmental Notices. To access the user guides, select the HP Support Assistant app on the
Start screen, select My computer, and then select User guides.

@NOTE: Volume can also be controlled through the operating system and some programs.

= NOTE: Refer to the Getting to know your computer on page 4 section for information on what type
of volume controls your computer has.

Connecting headphones and microphones

You can connect wired headphones or headsets to the audio-out (headphone) jack/audio-in
(microphone) jack on your computer. Many headsets with integrated microphones are commercially
available.

To connect wireless headphones or headsets to your computer, follow the device manufacturer's
instructions.

AWARNING! To reduce the risk of personal injury, lower the volume setting before putting on
headphones, earbuds, or a headset. For additional safety information, see the Regulatory, Safety and
Environmental Notices.

Checking audio functions on the computer

=?NOTE: For best results when recording, speak directly into the microphone and record sound in a
setting free of background noise.

To check the audio functions on your computer, follow these steps:
1. From the Start screen, type c, and then select Control Panel from the list of applications.
2. Select Hardware and Sound, and then select Sound.

When the Sound window opens, select the Sounds tab. Under Program Events, select any
sound event, such as a beep or alarm and then click Test. You should hear sound through the
speakers or through connected headphones.

To check the recording functions on your computer, follow these steps:
1. From the Start screen, type s, and then select Sound Recorder.
2. Click Start Recording and speak into the microphone. Save the file to your Windows desktop.

3. Open a multimedia program and play back the recording.
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To confirm or change the audio settings on your computer:
1. From the Start screen, type c, and then select Control Panel from the list of applications.

2. Select Hardware and Sound, and then select Sound.

Webcam (select models only)

Some computers include an integrated webcam. With the preinstalled software, you can use the
webcam to take a photo or record a video. You can preview and save the photo or video recording.

The webcam software enables you to experiment with the following features:
e  Capturing and sharing video
e  Streaming video with instant message software

e  Taking still photos

Video

Your HP computer is a powerful video device that enables you to watch streaming video from your
favorite websites and download video and movies to watch on your computer without needing to
connect to a network.

To enhance your viewing enjoyment, use one of the video ports on the computer to connect an
external monitor, projector, or TV.

Your computer may have one or more of the following external video ports:

e VGA

e DisplayPort

E/%?IMPORTANT: Be sure that the external device is connected to the correct port on the computer,
using the correct cable. Check the device manufacturer's instructions if you have questions.

@NOTE: Refer to the Getting to know your computer on page 4 section for information about your
computer's video ports.

VGA

The external monitor port, or VGA port, is an analog display interface that connects an external VGA
display device such as an external VGA monitor or a VGA projector to the computer.
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A To connect a VGA display device, connect the device cable to the external monitor port.

|mm]

DisplayPort

The DisplayPort connects the computer to an optional video or audio device, such as a high-definition
television, or to any compatible digital or audio component. The DisplayPort delivers higher
performance than the VGA external monitor port and improves digital connectivity.

%NOTE: To transmit video and/or audio signals through the DisplayPort, you need a DisplayPort
cable (purchased separately).

=»NOTE: One DisplayPort device can be connected to the DisplayPort port on the computer. The
information displayed on the computer screen can be simultaneously displayed on the DisplayPort
device.

To connect a video or audio device to the DisplayPort:

1. Connect one end of the DisplayPort cable to the DisplayPort port on the computer.

_

2. Connect the other end of the cable to the video device, and then see the device manufacturer’s
instructions for additional information.

@NOTE: To remove the device cable, press down on connector release button to disconnect it on the
computer.
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Intel Wireless Display (select models only)

Intel® Wireless Display allows you to share your computer content wirelessly on your TV. To
experience wireless display, a wireless TV adapter (purchased separately) is required. DVDs that
have output protection may not play on Intel Wireless Display. (However, DVDs that do not have
output protect will play.) Blu-ray discs, which have output protection, will not play on Intel Wireless
Display. For details about using the wireless TV adapter, see the manufacturer's instructions.

E’%NOTE: Be sure that wireless is enabled on your computer before using the wireless display.
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6 Power management

= NOTE: A computer may have a power button or a power switch. The term power button is used
throughout this guide to mean both types of power controls.

Shutting down the computer

ACAUTION: Unsaved information is lost when the computer shuts down.

The shutdown command closes all open programs, including the operating system, and then turns off
the display and computer.

Shut down the computer under any of the following conditions:
e When you need to replace the battery or access components inside the computer

e  When you are connecting an external hardware device that does not connect to a Universal
Serial Bus (USB) port

e  When the computer will be unused and disconnected from external power for an extended
period

Although you can turn off the computer with the power button, the recommended procedure is to use
the Windows shutdown command:

@NOTE: If the computer is in the Sleep state or in Hibernation, you must first exit Sleep or
Hibernation before shutdown is possible by briefly pressing the power button.

1. Save your work and close all open programs.
2. From the Start screen, point to the upper-right or lower-right corner of the screen.
3. Click Settings, click the Power icon, and then click Shut down.

If the computer is unresponsive and you are unable to use the preceding shutdown procedure, try the
following emergency procedures in the sequence provided:

e  Press ctrl+alt+delete. Click the Power icon, and then click Shut Down.
e Press and hold the power button for at least 5 seconds.
e Disconnect the computer from external power.

e  On models with a user-replaceable battery, remove the battery.
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Refreshing your software content with Intel Smart
Connect Technology

When the computer is in the Sleep state, Intel® Smart Connect Technology periodically causes the
computer to exit Sleep. If a network connection is available, Smart Connect updates open apps such
as your email inboxes, social network sites, and news pages and then returns the computer to the
Sleep state. Smart Connect also syncs content that you have created offline, such as emails. When
the computer exits Sleep, you have immediate access to your updated information.

e To enable this feature or manually adjust the settings, from the Start screen, type smart, and
then select then select Intel(R) Smart Connect Technology.

Setting power options

Using power-saving states
Sleep is enabled at the factory.

When Sleep is initiated, the power lights blink and the screen clears. Your work is saved to memory.

/\ CAUTION: To reduce the risk of possible audio and video degradation, loss of audio or video
playback functionality, or loss of information, do not initiate Sleep while reading from or writing to a
disc or an external memory card.

E%?NOTE: You cannot initiate any type of networking connection or perform any computer functions
while the computer is in the Sleep state.

Initiating and exiting Sleep
With the computer on, you can initiate Sleep in any of the following ways:
e  Briefly press the power button.

e  From the Start screen, point to the upper-right or lower-right corner of the screen. When the
charms list opens, click Settings, click the Power icon, and then click Sleep.

To exit Sleep, briefly press the power button.

When the computer exits Sleep, the power lights turn on and the computer returns to the screen
where you stopped working.

=¥ NOTE: If you have set a password to be required on wakeup, you must enter your Windows
password before the computer will return to the screen.

Enabling and exiting user-initiated Hibernation

You can enable user-initiated Hibernation and change other power settings and timeouts using Power
Options:

1. From the Start screen, type power, select Settings, and then select Power Options.
2. Inthe left pane, click Choose what the power button does.

3. Click Change Settings that are currently unavailable.
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4. Inthe When | press the power button area, select Hibernate.
5. Click Save changes.

To exit Hibernation, briefly press the power button. The power lights turn on and your work returns to
the screen where you stopped working.

@NOTE: If you have set a password to be required on wakeup, you must enter your Windows
password before your work will return to the screen.

Using the power meter and power settings

The power meter is located on the Windows desktop. The power meter allows you to quickly access
power settings and view the remaining battery charge.

e To display the percentage of remaining battery charge and the current power plan, on the
Windows desktop, point over the power meter icon.

e To use Power Options, or to change the power plan, click the power meter icon and select an
item from the list. From the Start screen, you can also type power, select Settings, and then
select Power Options.

Different power meter icons indicate whether the computer is running on battery or external power.
The icon also displays a message if the battery has reached a low or critical battery level.

Setting password protection on wakeup

To set the computer to prompt for a password when the computer exits Sleep or Hibernation, follow
these steps:

1. From the Start screen, type power, select Settings, and then select Power Options.
2. Inthe left pane, click Require a password on wakeup.
3. Click Change Settings that are currently unavailable.

4. Click Require a password (recommended).

E’%NOTE: If you need to create a user account password or change your current user account
password, click Create or change your user account password, and then follow the on-
screen instructions. If you do not need to create or change a user account password, go to step
5.

5. Click Save changes.

Using battery power

/\ WARNING! To reduce potential safety issues, use only the battery provided with the computer, a
replacement battery provided by HP, or a compatible battery purchased from HP.

The computer runs on battery power whenever it is not plugged into external AC power. Computer
battery life varies, depending on power management settings, running programs, display brightness,
external devices connected to the computer, and other factors. Keeping the battery in the computer
whenever the computer is plugged into AC power charges the battery and also protects your work in
case of a power outage. If the computer contains a charged battery and is running on external AC
power, the computer automatically switches to battery power if the AC adapter is disconnected on the
computer or an AC power loss occurs.
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E‘%NOTE: When you disconnect AC power, the display brightness is automatically decreased to save
battery life.

Finding additional battery information

HP Support Assistant provides the following tools and information about the battery. To access
battery information, select the HP Support Assistant app on the Start screen, and then select
Battery and performance.

e Battery Check tool to test battery performance

e Information on calibration, power management, and proper care and storage to maximize battery
life

e Information on battery types, specifications, life cycles, and capacity
To access battery information:

A Select the HP Support Assistant app on the Start screen, and then select Battery and
performance.

Using Battery Check
HP Support Assistant provides information on the status of the battery installed in the computer.
To run Battery Check:

1. Connect the AC adapter to the computer.

@’NOTE: The computer must be connected to external power for Battery Check to work properly.

2. To access battery information, select the HP Support Assistant app on the Start screen, and
then select Battery and performance.

Battery Check examines the battery and its cells to see if they are functioning properly, and then
reports the results of the examination.

Displaying the remaining battery charge

A Move the pointer over the power meter icon on the Windows desktop in the notification area, at
the far right of the taskbar.

Maximizing battery discharge time

Battery discharge time varies depending on features you use while on battery power. Maximum
discharge time gradually decreases as the battery storage capacity naturally degrades.

Tips for maximizing battery discharge time:
e Lower the brightness on the display.

e Remove the battery on the computer when it is not being used or charged, if the computer
contains a user-replaceable battery

e  Store the user-replaceable battery in a cool, dry location.

e  Select the Power saver setting in Power Options.

Setting power options 37



Managing low battery levels

The information in this section describes the alerts and system responses set at the factory. Some
low-battery alerts and system responses can be changed using Power Options. Preferences set
using Power Options do not affect lights.

From the Start screen, type power, select Settings, and then select Power Options.

Identifying low battery levels

When a battery that is the sole power source for the computer reaches a low or critical battery level,
the following behavior occurs:

e  The battery light (select models only) indicates a low or critical battery level.

e The power meter icon in the notification area shows a low or critical battery notification.

E/i"NOTE: For additional information about the power meter, see Using the power meter and
power settings on page 36.

If the computer is on or in the Sleep state, the computer remains briefly in the Sleep state, and then
shuts down and loses any unsaved information.

Resolving a low battery level
Resolving a low battery level when external power is available
A Connect one of the following devices:
e AC adapter
e  Optional docking or expansion device
e  Optional power adapter purchased as an accessory from HP
Resolving a low battery level when no power source is available

To resolve a low battery level when no power source is available, save your work and shut down the
computer.

Inserting or removing the battery

Inserting a battery
To insert the battery:

1. Insert the battery into the battery bay, aligning the tabs on the battery (1) with the notches on the
computer, and then press the battery down until it is seated.
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2. Slide the battery release latch (2) to lock the battery into place.

Removing a battery

To remove the battery:

/\ CAUTION: Removing a battery that is the sole power source for the computer can cause loss of
information. To prevent loss of information, save your work and shut down the computer through
Windows before removing the battery.

1. Remove the service door. See Removing or replacing the service door on page 49.
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2. Slide the two battery release latches to the unlocked position (1). You will be able to see red
beneath the latches. Using the cloth tab, tilt the battery up (2) and then lift it (3) out of the
enclosure.

Conserving battery power
e From the Start screen, type power, select Settings, and then select Power Options.
e  Select low power-use settings through Power Options.

e  Turn off wireless and LAN connections and exit modem applications when you are not using
them.

e Disconnect unused memory devices that are not plugged into an external power source.
e  Stop, disable, or remove any external media cards that you are not using.
e Decrease screen brightness.

e  Before you leave your work, initiate Sleep, or shut down the computer.

Storing a user-replaceable battery

/\ CAUTION: To reduce the risk of damage to a battery, do not expose it to high temperatures for
extended periods of time.

If a computer will be unused and unplugged from external power for more than 2 weeks, remove the
user-replaceable battery and store it separately.

To prolong the charge of a stored battery, place it in a cool, dry place.
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=¥ NOTE: A stored battery should be checked every 6 months. If the capacity is less than 50 percent,
recharge the battery before returning it to storage.

Calibrate a battery before using it if it has been stored for one month or more.

Disposing of a user-replaceable battery

AWARNING! To reduce the risk of fire or burns, do not disassemble, crush, or puncture; do not short
external contacts; do not dispose of in fire or water.

See the Regulatory, Safety and Environmental Notices for proper battery disposal. To access the
user guides, select the HP Support Assistant app on the Start screen, select My computer, and
then select User guides. To access battery information, select the HP Support Assistant app on the
Start screen, and then select Battery and performance.

Replacing a user-replaceable battery

Battery Check notifies you to replace the battery when an internal cell is not charging properly or
when the battery storage capacity has reached a weak condition. If the battery is possibly covered by
an HP warranty, instructions include a warranty ID. A message refers you to the HP website for more
information about ordering a replacement battery.

Using external AC power

/\ WARNING! Do not charge the computer battery while you are onboard aircraft.

AWARNING! To reduce potential safety issues, use only the AC adapter provided with the computer,
a replacement AC adapter provided by HP, or a compatible AC adapter purchased from HP.

E‘%NOTE: For information on connecting to AC power, see the Setup Instructions poster provided in
the computer box.

External AC power is supplied through an approved AC adapter or an optional docking or expansion
device.

Connect the computer to external AC power under any of the following conditions:
e  When charging or calibrating a battery

e  When installing or modifying system software

e  When writing information to a CD, a DVD, or a BD (select models only)

e  When running Disk Defragmenter

e  When performing a backup or recovery

When you connect the computer to external AC power, the following events occur:
e The battery begins to charge.

e If the computer is turned on, the power meter icon in the notification area changes appearance.
When you disconnect external AC power, the following events occur:

e  The computer switches to battery power.

e The display brightness is automatically decreased to save battery life.
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Testing an AC adapter

Test the AC adapter if the computer exhibits any of the following symptoms when it is connected to
AC power:

e  The computer does not turn on.
e The display does not turn on.
e  The power lights are off.

To test the AC adapter:

E/?’NOTE: The following instructions apply to computers with user-replaceable batteries.

1. Shut down the computer.
2. Remove the battery on the computer.
3. Connect the AC adapter to the computer, and then plug it into an AC outlet.
4. Turn on the computer.
e If the power lights turn on, the AC adapter is working properly.
e |f the power lights remain off, the AC adapter is not functioning and should be replaced.

Contact support for information on obtaining a replacement AC power adapter.
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7 External cards and devices

Using Memory Card Readers

Optional memory cards provide secure data storage and convenient data sharing. These cards are
often used with digital media—equipped cameras and PDAs as well as with other computers.

To determine the memory card formats that are supported on your computer, see the Getting to know
your computer on page 4 section.

Inserting a memory card

/\ CAUTION: To reduce the risk of damage to the memory card connectors, use minimal force to
insert a memory card.

1. Hold the memory card label-side up, with the connectors facing the computer.

2. Insert the card into the memory Card Reader, and then press in on the card until it is firmly
seated.

You will hear a sound when the device has been detected, and a menu of options may be
displayed.
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Removing a memory card

/\ CAUTION: To reduce the risk of loss of data or an unresponsive system, use the following
procedure to safely remove the memory card.

1. Save your information and close all programs associated with the memory card.

2. Click the remove hardware icon on the Windows desktop in the notification area, at the far right
of the taskbar. Then follow the on-screen instructions.

3. Pressin on the card (1), and then remove it from the slot (2).

>

E‘%NOTE: If the card does not eject, pull the memory card out of the slot.

Using smart cards

E/?’NOTE: The term smart card is used throughout this chapter to mean both smart cards and Java™
Cards.

A smart card is a credit card-sized accessory that carries a microchip containing memory and a
microprocessor. Like personal computers, smart cards have an operating system to manage input
and output, and they include security features to protect against tampering. Industry-standard smart
cards are used with the smart card reader (select models only).

A PIN is needed to gain access to the contents of the microchip. For more information about smart
card security features, access HP Support Assistant. To access HP Support Assistant on the Start
screen, select the HP Support Assistant app.

44 Chapter 7 External cards and devices



Inserting a smart card

1. Hold the card label-side up, and gently slide the card into the smart card reader until the card is

seated.

2. Follow the on-screen instructions for logging on to the computer using the smart card PIN.

Removing a smart card

A Grasp the edge of the smart card, and then pull it out of the smart card reader.

Using a USB device

Universal Serial Bus (USB) is a hardware interface that can be used to connect an optional external
device, such as a USB keyboard, mouse, drive, printer, scanner, or hub.

Some USB devices may require additional support software, which is usually included with the
device. For more information about device-specific software, see the manufacturer's instructions.
These instructions may be provided with the software, on disc, or on the manufacturer's website.

The computer has at least 1 USB port that supports USB 1.0, 1.1, 2.0, or 3.0 devices. Your computer
may also have a USB charging port that provides power to an external device. An optional docking
device or USB hub provides additional USB ports that can be used with the computer.

Using a USB device
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Connecting a USB device

/\ CAUTION: To reduce the risk of damage to a USB connector, use minimal force to connect the
device.

A Connect the USB cable for the device to the USB port.

r__*:"/?NOTE: The following illustration may look slightly different than your computer.

b

You will hear a sound when the device has been detected.

@NOTE: The first time you connect a USB device, a message in the notification area lets you know
that the device is recognized by the computer.

Removing a USB device

/\ CAUTION: To reduce the risk of damage to a USB connector, do not pull on the cable to remove
the USB device.

CAUTION: To reduce the risk of loss of information or an unresponsive system, use the following
procedure to safely remove the USB device.

1.  Toremove a USB device, save your information and close all programs associated with the
device.

2. Click the remove hardware icon on the Windows desktop in the notification area, at the far right
of the taskbar, and then follow the on-screen instructions.

3. Remove the device.

Using optional external devices

=?NOTE: For more information about required software and drivers, or to learn which computer port to
use, see the manufacturer's instructions.

To connect an external device to the computer:

46 Chapter 7 External cards and devices



A CAUTION: To reduce the risk of damage to the equipment when connecting a powered device, be
sure that the device is turned off and the AC power cord is unplugged.

1. Connect the device to the computer.
2. If you are connecting a powered device, plug the device power cord into a grounded AC outlet.
3. Turn on the device.

To disconnect an unpowered external device, turn off the device, and then disconnect it on the
computer. To disconnect a powered external device, turn off the device, disconnect it on the
computer, and then unplug the AC power cord.

Using optional external drives

Removable external drives expand your options for storing and accessing information. A USB drive
can be added by connecting the drive to a USB port to the computer.

E%?NOTE: HP external USB optical drives should be connected to the powered USB port to the
computer.

USB drives include the following types:

e 1.44-megabyte diskette drive

e  Hard drive module

e  External optical drive (CD, DVD, and Blu-ray)

e MultiBay device
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8 Drives

Handling drives

ACAUTION: Drives are fragile computer components that must be handled with care. Refer to the
following cautions before handling drives. Additional cautions are included with the procedures to
which they apply.

Observe these precautions:

Before you move a computer that is connected to an external hard drive, initiate Sleep and allow
the screen to clear, or properly disconnect the external hard drive.

Before handling a drive, discharge static electricity by touching the unpainted metal surface of
the drive.

Do not touch the connector pins on a removable drive or on the computer.
Handle a drive carefully; do not drop a drive or place items on it.

Before removing or inserting a drive, shut down the computer. If you are unsure whether the
computer is off, in the Sleep state, turn the computer on, and then shut it down through the
operating system.

Do not use excessive force when inserting a drive into a drive bay.

Do not type on the keyboard or move the computer while an optical drive is writing to a disc. The
write process is sensitive to vibration.

When the battery is the only source of power, be sure that the battery is sufficiently charged
before writing to media.

Avoid exposing a drive to temperature or humidity extremes.
Avoid exposing a drive to liquids. Do not spray the drive with cleaning products.

Remove media from a drive before removing the drive from the drive bay, or traveling with,
shipping, or storing a drive.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “FRAGILE.”

Avoid exposing a drive to magnetic fields. Security devices with magnetic fields include airport
walk-through devices and security wands. Airport conveyer belts and similar security devices
that check carry-on baggage use X-rays instead of magnetism and do not damage drives.
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Using hard drives

/\ CAUTION: To prevent information loss or an unresponsive system:

Save your work and shut down the computer before adding or replacing a memory module or hard
drive.

If you are not sure whether the computer is off, turn the computer on by pressing the power button.
Then shut down the computer through the operating system.

Removing or replacing the service door

Removing the service door

Remove the service door to access the battery, memory module slot, hard drive, and other
components.

1. With the computer turned over, slide the service door release latch to the unlock position (1).
and (2) remove the screw (if the optional screw is being used), or, if the screw is not in used,
simply slide the release latch to the right (3).

@NOTE: If you want to use the optional security screw, it is stored inside the service door.

2. Slide the service door towards the front of the computer (4) and lift to remove the service door

(5).

Using hard drives
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Replacing the service door

Replace the service door after accessing the battery, memory module slot, hard drive, regulatory
label, and other components.

1. Tilt down the service door to align the front edge of the service door near the front edge of the
computer (1).

2. Slide the service cover forwards (2) until it snaps into place.

3. With the battery bay toward you, slide the service door release latch to the right (3), and if you
choose to, insert and tighten the optional screw (4) to hold the service door in place. Slide the
release latch to the left to lock the service door (5).

E’%NOTE: If you want to use the optional screw, it is stored inside the service door.

Replacing or upgrading the hard drive

/\ CAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before removing the hard drive from the hard drive bay. Do not remove the
hard drive while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off, turn the computer on by pressing the power button.
Then shut down the computer through the operating system.
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Removing the hard drive

To remove a hard drive:

1.

2
3.
4

Save your work and shut down the computer.
Disconnect AC power and external devices connected to the computer.
Turn the computer upside down on a flat surface.

Remove the service door (see Removing or replacing the service door on page 49) and the
battery (see Inserting or removing the battery on page 38).

Loosen the 4 hard drive door screws (1). Pull the cloth hard drive tab (2) upwards, and then
remove the drive.

Installing a hard drive

E/%"NOTE: Your computer may look slightly different from the illustration in this section.

To install the hard drive:

1.

Place the hard drive into the hard drive bay, (1), ensuring that the cloth tab remains on top.

Using hard drives
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2. Replace the 4 screws (2) to secure the hard drive.

3. Replace the battery (see Inserting or removing the battery on page 38) and the service door (see
Removing or replacing the service door on page 49).

4. Turn the computer right-side up, and then reconnect AC power and external devices to the
computer.

5. Turn on the computer.

Adding or replacing memory

Adding or replacing memory modules

The computer has two memory module slots. The capacity of the computer can be upgraded by
adding a memory module to the vacant expansion memory module slot or by upgrading the existing
memory module in the primary memory module slot.

AWARNING! To reduce the risk of electric shock and damage to the equipment, unplug the power
cord and remove all batteries before installing a memory module.

/\ CAUTION: Electrostatic discharge (ESD) can damage electronic components. Before beginning
any procedure, ensure that you are discharged of static electricity by touching a grounded metal
object.

@NOTE: To use a dual-channel configuration when adding a second memory module, be sure that
both memory modules are identical.

To add or replace a memory module:
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A CAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before adding or replacing memory modules. Do not remove a memory
module while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

1.

2
3.
4

Save your work and shut down the computer.
Disconnect AC power and external devices connected to the computer.
Turn the computer upside down on a flat surface.

Remove the battery (see Inserting or removing the battery on page 38) and the service door
(see Removing or replacing the service door on page 49).

If you are replacing a memory module, remove the existing memory module:
a. Pull away the retention clips (1) on each side of the memory module.
The memory module tilts up.

b. Grasp the edge of the memory module (2), and then gently pull the memory module out of
the memory module slot.

ACAUTION: To prevent damage to the memory module, hold the memory module by the
edges only. Do not touch the components on the memory module.

To protect a memory module after removal, place it in an electrostatic-safe container.
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6. Insert a new memory module:

ACAUTION: To prevent damage to the memory module, hold the memory module by the edges
only. Do not touch the components on the memory module.

a. Align the notched edge (1) of the memory module with the tab in the memory module slot.

b. With the memory module at a 45-degree angle from the surface of the memory module
compartment, press the module (2) into the memory module slot until it is seated.

c. Gently press the memory module (3) down, applying pressure to both the left and right
edges of the memory module, until the retention clips snap into place.

A CAUTION: To prevent damage to the memory module, be sure that you do not bend the
memory module.

7. Replace the battery (see Inserting or removing the battery on page 38) and the service door (see
Removing or replacing the service door on page 49).

8.  Turn the computer right-side up, and then reconnect AC power and external devices to the
computer.

9. Turn on the computer.
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Improving hard drive performance

Using Disk Defragmenter

As you use the computer, files on the hard drive become fragmented. Disk Defragmenter
consolidates the fragmented files and folders on the hard drive so that the system can run more
efficiently.

|‘__*:"/i"NOTE: It is not necessary to run Disk Defragmenter on solid-state drives.

After you start Disk Defragmenter, it works without supervision. Depending on the size of your hard
drive and the number of fragmented files, Disk Defragmenter may take more than an hour to
complete. You may want to set it to run during the night or at another time when you do not need
access to your computer.

HP recommends defragmenting your hard drive at least once a month. You may set Disk
Defragmenter to run on a monthly schedule, but you can defragment your computer manually at any
time.

To run Disk Defragmenter:
1. Connect the computer to AC power.

2. On the Start screen, type disk, click Settings, and then select Defragment and optimize your
drives.

3. Click Optimize.

@NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to HP Support Assistant. To
access HP Support Assistant on the Start screen, select the HP Support Assistant app.

For additional information, access the Disk Defragmenter software Help.

Using Disk Cleanup

Disk Cleanup searches the hard drive for unnecessary files that you can safely delete to free up disk
space and help the computer to run more efficiently.

To run Disk Cleanup:

1. On the Start screen, type disk, click Settings, and then select Free up disk space by deleting
unnecessary files.

2. Follow the on-screen instructions.

Identifying HP 3D DriveGuard status

The hard drive light on the computer changes color to show that the drive in a primary hard drive bay
and/or the drive in a secondary hard drive bay (select models only) is parked. To determine whether a
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drive is currently protected or whether it is parked, view the icon on the Windows desktop in the
notification area, at the far right of the taskbar, or in the Mobility Center:
®  If the software is actively protecting the drive, a green check mark @ is superimposed over the

icon.

If the software has been disabled, a no symbol r

fj is superimposed over the icon.

If the software has parked the drive due to a shock event, an orange cone @ is superimposed
over the icon.
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9 Security

Protecting the computer

Standard security features provided by the Windows operating system and the non-Windows
Computer Setup utility (BIOS) can protect your personal settings and data from a variety of risks.

@NOTE: Security solutions are designed to act as deterrents. These deterrents may not prevent a

product from being mishandled or stolen.

E/i"NOTE: Before you send your computer for service, back up and delete confidential files, and

remove all password settings.

@NOTE: Some features listed in this chapter may not be available on your computer.

E’%NOTE: Your computer supports Computrace, which is an online security-based tracking and

recovery service available in select regions. If the computer is stolen, Computrace can track the
computer if the unauthorized user accesses the Internet. You must purchase the software and
subscribe to the service in order to use Computrace. For information about ordering the Computrace
software, go to the HP website at http://hp-pt.absolute.com.

E’%NOTE: If a webcam is installed or connected to the computer, and if the Face Recognition program

is installed, you can set the security level for Face Recognition to balance the ease of use and the
difficulty of breaching the security of the computer. Refer to the HP ProtectTools Getting Started

guide or the Face Recognition software Help.

Computer risk

Security feature

Unauthorized use of the computer

HP Client Security, in combination with a password, smart
card, contactless card, registered face scenes, registered
fingerprints, or other authentication credential

Unauthorized access to Computer Setup (f10)

BIOS administrator password in Computer Setup*

Unauthorized access to the contents of a hard drive

DriveLock password or Automatic DriveLock password in
Computer Setup*

Unauthorized startup from an optional external optical drive
(select models only), optional external hard drive (select
models only), or internal network adapter

Boot options feature in Computer Setup*

Unauthorized access to a Windows user account

Windows user password

Unauthorized access to data

e  HP Drive Encryption software

e  Windows Defender

Unauthorized access to Computer Setup settings and other
system identification information

BIOS administrator password in Computer Setup*

Protecting the computer
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Computer risk Security feature

Unauthorized removal of the computer Security cable slot (used with an optional security cable)

*Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not working or will
not load. You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and
make selections in Computer Setup.

Using passwords

A password is a group of characters that you choose to secure your computer information. Several
types of passwords can be set, depending on how you want to control access to your information.
Passwords can be set in Windows or in the non-Windows Computer Setup utility that is preinstalled
on the computer.

e  Setup, DriveLock and Automatic DriveLock passwords are set in Computer Setup and are
managed by the system BIOS.

e The embedded security password, which is an HP ProtectTools Security Manager password,
can be enabled in Computer Setup to provide BIOS password protection in addition to its normal
HP ProtectTools functions. The embedded security password is used with the optional
embedded security chip.

e  Windows passwords are set only in the Windows operating system.

e If HP SpareKey has been set up previously, and if you forget the BIOS administrator password
set in Computer Setup, you can use HP SpareKey to access the utility.

e If you forget both the DriveLock user password and the DriveLock master password set in
Computer Setup, the hard drive that is protected by the passwords is permanently locked and
can no longer be used.

You can use the same password for a Computer Setup feature and for a Windows security feature.
You can also use the same password for more than one Computer Setup feature.

Use the following tips for creating and saving passwords:
e  When creating passwords, follow requirements set by the program.

e Do not use the same password for multiple applications or websites, and do not reuse your
Windows password for any other application or website.

e Use HP Password Manager to store your user names and passwords for all of your websites
and applications. You can securely read them in the future if they cannot be remembered.

e Do not store passwords in a file on the computer.

The following tables list commonly used Windows and BIOS administrator passwords and describe
their functions.
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Setting passwords in Windows

Password

Function

Administrator password*

Protects access to a Windows administrator-level account.

NOTE: Setting the Windows Administrator password does
not set the BIOS Administrator password.

User password*

Protects access to a Windows user account.

*For information about setting a Windows administrator password or a Windows user password from the Start screen,
access HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP Support Assistant app.

Setting passwords in Computer Setup

Password

Function

BIOS administrator password*

Protects access to Computer Setup.

NOTE: If features have been enabled to prevent removing
the BIOS administrator password, you may not be able to
remove it until those features have been disabled.

DriveLock master password*

Protects access to the internal hard drive that is protected by
DriveLock. It is also used to remove DrivelLock protection.
This password is set under DriveLock Passwords during the
enable process.

NOTE: A BIOS Administrator password must be set before
you can set a DriveLock password.

DriveLock user password*

Protects access to the internal hard drive that is protected by
DriveLock, and is set under DriveLock Passwords during the
enable process.

NOTE: A BIOS Administrator password must be set before
you can set a DriveLock password.

*For details about each of these passwords, see the following topics.

Managing a BIOS administrator password

To set, change, or delete this password, follow these steps:

Setting a new BIOS administrator password

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Security > Setup BIOS Administrator

Password, and then press enter.

4. When prompted, type a password.
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When prompted, type the new password again to confirm.

To save your changes and exit Computer Setup, click the Save icon and then follow the on-
screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Changing a BIOS administrator password

1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Security > Change Password, and then press
enter.

When prompted, type your current password.
When prompted, type your new password again to confirm.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Deleting a BIOS administrator password

1.

g

P
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Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Security > Change Password, and then press
enter.

When prompted, type your current password.

When prompted for the new password, leave the field empty, and then press enter.

Read the warning. To continue, select YES.

When prompted to type your new password again, leave the field empty, and then press enter.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
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Entering a BIOS administrator password

At the BIOS administrator password prompt, type your password (using the same kind of keys you
used to set the password), and then press enter. After 3 unsuccessful attempts to enter the BIOS
administrator password, you must restart the computer and try again.

Managing a Computer Setup DriveLock password

ACAUTION: To prevent the DriveLock-protected hard drive from becoming permanently unusable,
record the DriveLock user password and the DriveLock master password in a safe place away from

your computer. If you forget both DriveLock passwords, the hard drive will be permanently locked and

can no longer be used.

DriveLock protection prevents unauthorized access to the contents of a hard drive. DriveLock can be
applied only to the internal hard drive(s) of the computer. After DriveLock protection is applied to a
drive, a password must be entered to access the drive. The drive must be inserted into the computer
or an advanced port replicator in order for it to be accessed by the DrivelLock passwords.

E%?NOTE: A BIOS Administrator password must be set before you can access the DriveLock features.

To apply DriveLock protection to an internal hard drive, a user password and a master password
must be set in Computer Setup. Note the following considerations about using DriveLock protection:

After DriveLock protection is applied to a hard drive, the hard drive can be accessed only by
entering either the user password or the master password.

The owner of the user password should be the day-to-day user of the protected hard drive. The
owner of the master password may be either a system administrator or the day-to-day user.

The user password and the master password can be identical.

You can delete a user password or master password only by removing DriveLock protection
from the drive. DriveLock protection can be removed from the drive only with the master
password.

Setting a DriveLock password

To set a DriveLock password in Computer Setup, follow these steps:

1.
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Turn on the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Security > DriveLock, and then press enter.
Click Set DriveLock Password (global).

Enter the BIOS Administrator password, and then press enter.

Use a pointing device or the arrow keys to select the hard drive you want to protect, and then
press enter.

Read the warning. To continue, select YES.
When prompted, type a master password, and then press enter.

When prompted, type the master password again to confirm, and then press enter.

Using passwords

61



10.
11.
12.

When prompted, type a user password, and then press enter.
When prompted, type the user password again to confirm, and then press enter.

To confirm DriveLock protection on the drive you have selected, type DriveLock in the
confirmation field, and then press enter.

|‘__*:"/i"NOTE: The DriveLock confirmation is case sensitive.

13.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering a DriveLock password

Be sure that the hard drive is inserted into the computer (not into an optional docking device or
external MultiBay).

At the DriveLock Password prompt, type your user or master password (using the same kind of
keys you used to set the password), and then press enter.

After 2 incorrect attempts to enter the password, you must shut down the computer and try again.

Changing a DriveLock password

To change a DriveLock password in Computer Setup, follow these steps:

1.
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11.
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Turn on the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Security > DriveLock, and then press enter.
Enter the BIOS Administrator password, and then press enter.

Use a pointing device or the arrow keys select Set DriveLock Password, and then press enter.
Use the arrow keys to select an internal hard drive, and then press enter.

Use a pointing device or the arrow keys to select Change Password.

When prompted, type your current password, and then press enter.

When prompted, type a new password, and then press enter.

When prompted, type the new password again to confirm, and then press enter.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.
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Your changes go into effect when the computer restarts.

Removing DriveLock protection

To remove DrivelLock protection in Computer Setup, follow these steps:

1.
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Turn on the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.
Use a pointing device or the arrow keys to select Security > DriveLock, and then press enter.
Enter the BIOS Administrator password, and then press enter.

Use a pointing device or the arrow keys to select Set DriveLock Password, and then press
enter.

Use a pointing device or the arrow keys to select an internal hard drive, and then press enter.
Use a pointing device or the arrow keys to select Disable protection.
Type your master password, and then press enter.

To save your changes and exit Computer Setup, click the Save icon and then follow the on-
screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Using Computer Setup Automatic DriveLock

In a multiple-user environment, you can set an Automatic DriveLock password. When the Automatic
DriveLock password is enabled, a random user password and a DriveLock master password will be
created for you. When any user passes the password credential, the same random user and
DriveLock master password will be used to unlock the drive.

=¥ NOTE: A BIOS Administrator password must be set before you can access the Automatic
DriveLock features.

Entering an Automatic DriveLock password

To enable an Automatic DriveLock password in Computer Setup, follow these steps:

1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Security > Automatic DriveLock, and then
press enter.

Enter the BIOS Administrator password, and then press enter.

Use a pointing device or the arrow keys to select an internal hard drive, and then press enter.
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6. Read the warning. To continue, select YES.

7. To save your changes and exit Computer Setup, click the Save icon and then follow the on-
screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Removing Automatic DriveLock protection
To remove DrivelLock protection in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Security > Automatic DriveLock, and then
press enter.

4. Enter the BIOS Administrator password, and then press enter.

5. Use a pointing device or the arrow keys to select an internal hard drive, and then press enter.

6. Use a pointing device or the arrow keys to select Disable protection.

7. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of

the screen, and then follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Using antivirus software

When you use the computer to access e-mail, a network, or the Internet, you potentially expose it to
computer viruses. Computer viruses can disable the operating system, programs, or utilities, or cause
them to function abnormally.

Antivirus software can detect most viruses, destroy them, and, in most cases, repair any damage they
have caused. To provide ongoing protection against newly discovered viruses, antivirus software
must be kept up to date.

Windows Defender is preinstalled on your computer. It is strongly recommended that you continue to
use an antivirus program in order to fully protect your computer..

For more information about computer viruses, access HP Support Assistant. To access HP Support
Assistant on the Start screen, select the HP Support Assistant app.

Using firewall software

Firewalls are designed to prevent unauthorized access to a system or network. A firewall can be a
software program you install on your computer and/or network, or it can be a solution made up of
both hardware and software.
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There are two types of firewalls to consider:
e Host-based firewalls—Software that protects only the computer it is installed on.

e Network-based firewalls—Installed between your DSL or cable modem and your home network
to protect all the computers on the network.

When a firewall is installed on a system, all data sent to and from the system is monitored and
compared with a set of user-defined security criteria. Any data that does not meet those criteria is
blocked.

Your computer or networking equipment may already have a firewall installed. If not, firewall software
solutions are available.

=»NOTE: Under some circumstances a firewall can block access to Internet games, interfere with

printer or file sharing on a network, or block authorized e-mail attachments. To temporarily resolve the
problem, disable the firewall, perform the task that you want to perform, and then reenable the
firewall. To permanently resolve the problem, reconfigure the firewall.

Installing critical security updates

A CAUTION: Microsoft® sends out alerts regarding critical updates. To protect the computer from

security breaches and computer viruses, install all critical updates from Microsoft as soon as you
receive an alert.

You can choose whether updates are installed automatically. To change the settings, from the Start
screen, type c, and then select Control Panel. Select System and Security, select Windows
Update, select Change settings, and then follow the on-screen instructions.

Using HP Client Security Manager

HP Client Security software is preinstalled on most computer models. This software can be accessed
through the HP Client Security tile on the Start screen, the HP Client Security icon in the notification
area at the far right of the taskbar, or Windows Control Panel. It provides security features that help
protect against unauthorized access to the computer, networks, and critical data. For more
information, see the HP Client Security software Help.

Using the fingerprint reader (select models only)

Integrated fingerprint readers are available on select computer models. In order to use the fingerprint
reader, you must enroll your fingerprints in the HP Client Security's Credential Manager. Refer to the
HP Client Security software Help.

After you enroll your fingerprints in Credential Manager, you can use HP Password Manager to store
and fill in your user names and passwords in supported websites and applications.

Locating the fingerprint reader

The fingerprint reader is a small metallic sensor that is located in one of the following areas of your
computer:

e  On the right side of the keyboard

Installing critical security updates
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Depending on your computer model, the reader may be oriented horizontally or vertically. Both
orientations require that you swipe your finger perpendicular to the metallic sensor. Refer to the
Getting to know your computer on page 4 section for the location of the reader on your computer.
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10 Maintenance

Adding or replacing memory modules

The computer has one memory module compartment. The capacity of the computer can be upgraded
by adding a memory module to the vacant expansion memory module slot or by upgrading the
existing memory module in the primary memory module slot.

AWARNING! To reduce the risk of electric shock and damage to the equipment, unplug the power
cord and remove all batteries before installing a memory module.

/\ CAUTION: Electrostatic discharge (ESD) can damage electronic components. Before beginning
any procedure, ensure that you are discharged of static electricity by touching a grounded metal
object.

CAUTION: To prevent information loss or an unresponsive system:

Shut down the computer before adding or replacing memory modules. Do not remove a memory
module while the computer is on, in the Sleep state, or in Hibernation.

If you are not sure whether the computer is off or in Hibernation, turn the computer on by pressing the
power button. Then shut down the computer through the operating system.

E/?NOTE: To use a dual-channel configuration when adding a second memory module, be sure that
both memory modules are identical.

@NOTE: The primary memory is located in the bottom memory slot and the expansion memory is
located in the top memory slot.

To add or replace a memory module:
1. Save your work and shut down the computer.
Disconnect AC power and external devices connected to the computer.

Remove the battery (see Inserting or removing the battery on page 38).

2
3
4. Remove the service door (see Removing or replacing the service door on page 49).
5. If you are replacing a memory module, remove the existing memory module:

a. Pull away the retention clips (1) on each side of the memory module.

The memory module tilts up.
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b. Grasp the edge of the memory module (2), and then gently pull the memory module out of
the memory module slot.

A CAUTION: To prevent damage to the memory module, hold the memory module by the
edges only. Do not touch the components on the memory module.

To protect a memory module after removal, place it in an electrostatic-safe container.

6. Insert a new memory module:

ACAUTION: To prevent damage to the memory module, hold the memory module by the edges
only. Do not touch the components on the memory module.

a. Align the notched edge (1) of the memory module with the tab in the memory module slot.

b. With the memory module at a 45-degree angle from the surface of the memory module
compartment, press the module (2) into the memory module slot until it is seated.
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c. Gently press the memory module (3) down, applying pressure to both the left and right
edges of the memory module, until the retention clips snap into place.

ACAUTION: To prevent damage to the memory module, be sure that you do not bend the
memory module.

7. Replace the service door (see Removing or replacing the service door on page 49).

8. Insert the battery (see Inserting or removing the battery on page 38).

9. Connect AC power and external devices to the computer.

10. Turn on the computer.

Cleaning your computer

Cleaning products
Use the following products to safely clean and disinfect your computer:

e  Dimethyl benzyl ammonium chloride 0.3 percent maximum concentration (For example:
germicidal disposable wipes. These wipes come in a variety of brand names.)

e Alcohol-free glass cleaning fluid

e  Water with mild soap solution
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e  Dry microfiber cleaning cloth or a chamois (static-free cloth without oil)

e  Static-free cloth wipes

/\ CAUTION: Avoid the following cleaning products:

Strong solvents, such as alcohol, acetone, ammonium chloride, methylene chloride, and
hydrocarbons, which can permanently damage the surface of the computer.

Fibrous materials, such as paper towels, which can scratch the computer. Over time, dirt particles
and cleaning agents can get trapped in the scratches.

Cleaning procedures

Follow the procedures in this section to safely clean your computer.

AWARNING! To prevent electric shock or damage to components, do not attempt to clean your
computer while it is turned on:

Turn off the computer.
Disconnect external power.
Disconnect all powered external devices.

/\ CAUTION: Do not spray cleaning agents or liquids directly on any computer surface. Liquids
dripped on the surface can permanently damage internal components.

Cleaning the display

Gently wipe the display using a soft, lint-free cloth moistened with an alcohol-free glass cleaner. Be
sure that the display is dry before closing the display.

Cleaning the sides and cover

To clean and disinfect the sides and cover, use a soft microfiber cloth or chamois moistened with one
of the cleaning solutions listed previously or use an acceptable germicidal disposable wipe.

= NOTE: When cleaning the cover of the computer, use a circular motion to aid in removing dirt and
debris.

Cleaning the TouchPad and keyboard

/\ WARNING! To reduce the risk of electric shock or damage to internal components, do not use a
vacuum cleaner attachment to clean the keyboard. A vacuum cleaner can deposit household debris
on the keyboard surface.

ACAUTION: When cleaning the TouchPad and keyboard, do not let liquids drip between the keys.
This can permanently damage internal components.

e To clean and disinfect the TouchPad and keyboard, use a soft microfiber cloth or chamois
moistened with one of the cleaning solutions listed previously or use an acceptable germicidal
disposable wipe.

e To prevent keys from sticking and to remove dust, lint, and particles from the keyboard, use a
can of compressed air with a straw extension.
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Updating programs and drivers

HP recommends that you update your programs and drivers on a regular basis with the latest
versions. Go to http://www.hp.com/support to download the latest versions. You can also register to
receive automatic update notifications when they become available.

Using SoftPaq Download Manager

HP SoftPaq Download Manager (SDM) is a tool that provides quick access to SoftPaq information for
HP business computers without requiring the SoftPaq number. Using this tool, you can easily search
for SoftPaqgs, and then download and unpack them.

SoftPaq Download Manager works by reading and downloading, from the HP FTP site, a published
database file containing computer model and SoftPaq information. SoftPag Download Manager
allows you to specify one or more computer models to determine which SoftPaqs are available for
download.

SoftPaq Download Manager checks the HP FTP site for updates to the database and software. If
updates are found, they are downloaded and applied automatically.

SoftPaq Download Manager is available on the HP website. To use SoftPaq Download Manager to
download SoftPaqgs, you must first download and install the program. Go to the HP website at
http://www.hp.com/go/sdm, and follow the instructions to download and install SoftPaq Download
Manager.

To download SoftPags:

A From the Start screen, type s. In the search box, type softpaq, and then select HP SoftPaq
Download Manager. Follow the instructions to download SoftPags.

@NOTE: If prompted by User Account Control, click Yes.
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11 Backup and recovery

To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of your
computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed
options.

@NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

@NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to HP Support Assistant. To access
HP Support Assistant on the Start screen, select the HP Support Assistant app.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system
repair media and your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair media (select models only) are used to start up (boot)
the computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

On Start screen, type backup, click Settings, and then select Save backup copies of your files
with File History.

You can back up your information to an optional external hard drive or a network drive.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a backup using Backup and Restore:

E’%NOTE: Be sure that the computer is connected to AC power before you start the backup process.

E’%NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

E’%NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see Using
Windows 8 operating system media (purchased separately) on page 75.

Using the Windows recovery tools
To recover information you previously backed up:

A Access HP Support Assistant. To access HP Support Assistant on the Start screen, select the
HP Support Assistant app.

To recover your information using Automatic Repair, follow these steps:
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ACAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. All
files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition and the Windows partition.
From the Start screen, type e, and then click File Explorer.
—or—

From the Start screen, type c, and then select Computer.

g/%"NOTE: If the Windows partition and the Recovery Image partition are not listed, you must
recover your operating system and programs using the Windows 8 operating system DVD and
the Driver Recovery media (both purchased separately). For additional information, see Using
Windows 8 operating system media (purchased separately) on page 75.

3. Ifthe Windows partition and the Recovery Image partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

@NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in HP Support Assistant. To access HP Support Assistant on the Start screen,
select the HP Support Assistant app.

Using 11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C,
and then select Computer.

E‘%NOTE: If the Recovery Image partition is not listed, you must recover your operating system
and programs using the Windows 8 operating system media and the Driver Recovery media
(both purchased separately). For additional information, see Using Windows 8 operating system
media (purchased separately) on page 75.

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the
“Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using Windows 8 operating system media (purchased separately)

E%?NOTE: Your computer may not come equipped with an internal optical drive. In order to use the
operating system DVD, you may need to plug in an external optical drive.

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

E‘%NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

E}?IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

=¥ NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See HP Support Assistant for instructions on
reinstalling traditional applications. To access HP Support Assistant on the Start screen, select the
HP Support Assistant app.

E’%NOTE: You may be prompted for your permission or password when using Refresh. See HP
Support Assistant for more information. To access HP Support Assistant on the Start screen, select
the HP Support Assistant app.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.
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Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Scroll the right-side choices down to display Refresh your PC without affecting your files.

Under Refresh your PC without affecting your files, select Get started, and follow the on-
screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option
removes all personal data, apps, and settings from your computer, and reinstalls Windows.

@IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the 11 key or from the Start screen.

To use the f11 key:

1.

2
3
4,
5

Press f11 while the computer boots.

—or—

Press and hold f11 as you press the power button.
Choose your language.

Choose your keyboard layout.

Select Troubleshoot from the boot options menu.

Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1.
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On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

Click Settings.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

Scroll the right-side choices down to display Remove everything and reinstall Windows.

Under Remove everything and reinstall Windows, select Get started, and follow the on-
screen instructions.
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Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or
deleted from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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12 Computer Setup (BIOS), MultiBoot, and
HP PC Hardware Diagnostics (UEFI)

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

=»NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

@NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press 10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key on the keyboard.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

E/%"NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:
e To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen
instructions.

Use the tab key and the arrow keys to select Main > Ignore Changes and Exit, and then press
enter.

e To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-screen
instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

|‘__*:"/i"NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Main > Restore Defaults.

B

Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E%"%NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.
2. Use a pointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select Main > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update for Windows 8

/\ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type support, and then select the HP Support Assistant app.

2. Select Updates and tune-ups, and then select Check for HP updates now.
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3. Follow the on-screen instructions.

@NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

4. Atthe download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed
on your computer. Make a note of the date, name, or other identifier. You may need this
information to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your
hard drive where the BIOS update is downloaded. You will need to access this path when
you are ready to install the update.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then select File Explorer.
2.  Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

E%?NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility,
which is enabled at the factory, controls the order in which the system selects a boot device. Boot
devices can include optical drives, diskette drives, a network interface card (NIC), hard drives, and
USB devices. Boot devices contain bootable media or files that the computer needs to start and
operate properly.

E’%NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the
boot order.

You can change the order in which the computer searches for a boot device by changing the boot
order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then press 9. Pressing f9 displays a menu
that shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot
Express to set the computer to prompt you for a boot location each time the computer turns on or
restarts.
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Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

To set a new boot order that the computer uses each time it is turned on, by changing the boot
order in Computer Setup.

To dynamically choose the boot device, by pressing esc while the “Press the ESC key for
Startup Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter
the Boot Device Options menu.

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device
each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on
or restarted, follow these steps:

1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Advanced > Boot Options > UEFI Boot
Order for UEFI Hybrid or UEFI Native Boot Mode, or select Advanced > Boot Options >
Legacy Boot Order for Legacy Boot Mode, and then press enter.

To move the device up in the boot order, use a pointing device to click the up arrow, or press the
+ key.

To move the device down in the boot order, use a pointing device to click the down arrow, or
press the - key.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
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To dynamically choose a boot device for the current startup sequence, follow these steps:

1.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing
esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen.

Press 9.

Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each
time the computer is started or restarted, follow these steps:

1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter Computer Setup.

Use a pointing device or the arrow keys to select Advanced > Boot Options> MultiBoot
Express Boot Popup Delay (Sec), and then press enter.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you
want the computer to display the startup location menu before it defaults to the current MultiBoot

setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

To specify a boot device from the Express Boot menu, select your preference within the allotted
time, and then press enter.

To prevent the computer from defaulting to the current MultiBoot setting, press any key before
the allotted time expires. The computer will not start until you select a boot device and press
enter.

To allow the computer to start according to the current MultiBoot settings, wait for the allotted
time to expire

Using HP PC Hardware Diagnostics (UEFI) (select models

only)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run

diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside
of the operating system to isolate hardware failures from issues that may be caused by the operating
system or other software components.

Using HP PC Hardware Diagnostics (UEFI) (select models only)
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To start HP PC Hardware Diagnostics UEFI:
1. Turn on or restart the computer, quickly press esc, and then press 2.

After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI)
tools in the following order:

a. Connected USB drive

r__f%NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 84.

b. Hard drive
c. BIOS

2. Click the type of diagnostic test you want to run, and then follow the on-screen instructions.

E”%NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

=?NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English
only.

1. Go to http://www.hp.com.

2. Click Support & Drivers, and then click the Drivers & Software tab.

3. Enter the product name in the text box, and then click Search.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.
—or—

Click Download, and then select Run.
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13 Support

Contacting support

If the information provided in this user guide or HP Support Assistant does not address your
questions, you can contact support. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

Here you can:

° Chat online with an HP technician.

@NOTE: When support chat is not available in a particular language, it is available in English.

e  E-mail support.
e  Find support telephone numbers.

° Locate an HP service center.
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Labels

The labels affixed to the computer provide information you may need when you troubleshoot system
problems or travel internationally with the computer:

e  Service label—Provides important information, including the following:

?

2 X000
©—{ Serial: 2000000 IMIRINNNERIMEMIN |

—Product: J0000GOCC | IR EE
L Warranty: 1y1y0y
_ Model: XO0000(K

-

Component

1) Product name

(2) Serial number (s/n)

(3) Part number/Product number (p/n)
(4) Warranty period

(5) Model number (select models only)

Have this information available when you contact support. The service label is affixed inside the
battery bay.

e  Microsoft® Certificate of Authenticity—Contains the Windows Product Key. You may need the
Product Key to update or troubleshoot the operating system. The Microsoft Certificate of
Authenticity is affixed inside the battery bay.

e Regulatory label—Provides regulatory information about the computer. The regulatory label is
affixed inside the battery bay.

e  Wireless certification label or labels (select models only)—Provide information about optional
wireless devices and the approval markings of some of the countries or regions in which the
devices have been approved for use. If your computer model includes one or more wireless
devices, one or more certification labels are included with your computer. You may need this
information when traveling internationally. Wireless certification labels are affixed inside the
battery bay.

e  SIM (subscriber identity module) label (select models only)—Provides the ICCID (Integrated
Circuit Card Identifier) of the SIM. This label is located inside the battery bay.

e HP Mobile Broadband Module service label (select models only)—Provides the serial number of
the HP Mobile Broadband Module. This label is located inside the battery bay.
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14 Specifications

° Input power

° Operating environment

Input power

The power information in this section may be helpful if you plan to travel internationally with the
computer.

The computer operates on DC power, which can be supplied by an AC or a DC power source. The
AC power source must be rated at 100-240 V, 50-60 Hz. Although the computer can be powered

from a standalone DC power source, it should be powered only with an AC adapter or a DC power
source supplied and approved by HP for use with this computer.

The computer can operate on DC power within the following specifications.

Input Power Rating

Operating voltage and current 19.5Vdc @ 2.31 A-45W

195Vdc@3.33A-65W

E%?NOTE: This product is designed for IT power systems in Norway with phase-to-phase voltage not
exceeding 240 V rms.

@NOTE: The computer operating voltage and current can be found on the system regulatory label.

Input power
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Operating environment

Factor Metric u.s.
Temperature
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90% 10% to 90%
Nonoperating 5% to 95% 5% to 95%
Maximum altitude (unpressurized)

Operating -15m to 3,048 m -50 ft to 10,000 ft

Nonoperating

-“15mto 12,192 m

-50 ft to 40,000 ft
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Traveling with the computer

For best results, follow these traveling and shipping tips:

Prepare the computer for traveling or shipping:
° Back up your information.

° Remove all discs and all external media cards, such as digital cards.

/\ CAUTION: To reduce the risk of damage to the computer, damage to a drive, or loss of
information, remove the media from a drive before removing the drive from a drive bay and
before shipping, storing, or traveling with a drive.

° Turn off and then disconnect all external devices.
° Shut down the computer.
Take along a backup of your information. Keep the backup separate on the computer.

When traveling by air, carry the computer as hand luggage; do not check it in with the rest of
your bags.

/\ CAUTION: Avoid exposing a drive to magnetic fields. Security devices with magnetic fields

include airport walk-through devices and security wands. Airport conveyer belts and similar
security devices that check carry-on baggage use X-rays instead of magnetism and do not
damage drives.

In-flight computer use is at the discretion of the airline. If you plan to use the computer during a
flight, check with the airline in advance.

If the computer will be unused and disconnected from external power for more than 2 weeks,
remove the battery and store it separately.

If you are shipping the computer or a drive, use suitable protective packaging and label the
package “FRAGILE.”

If the computer has a wireless device or an HP Mobile Broadband Module installed, such as an
802.11b/g device, a Global System for Mobile Communications (GSM) device, or a General
Packet Radio Service (GPRS) device, the use of these devices may be restricted in some
environments. Such restrictions may apply onboard aircraft, in hospitals, near explosives, and in
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hazardous locations. If you are uncertain of the policy that applies to the use of a particular
device, ask for authorization to use it before you turn it on.

e If you are traveling internationally, follow these suggestions:

° Check the computer-related customs regulations for each country or region on your
itinerary.

° Check the power cord and adapter requirements for each location in which you plan to use
the computer. Voltage, frequency, and plug configurations vary.

AWARNING! To reduce the risk of electric shock, fire, or damage to the equipment, do not
attempt to power the computer with a voltage converter kit sold for appliances.
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B Troubleshooting

Troubleshooting resources

e Access website links and additional information about the computer through HP Support
Assistant. To access HP Support Assistant on the Start screen, select the HP Support
Assistant app.

@NOTE: Some checkup and repair tools require an Internet connection. HP also provides
additional tools that do not require an Internet connection.

e  Contact HP support. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

Choose from the following types of support:

o Chat online with an HP technician.

E%V?NOTE: When chat is not available in a particular language, it is available in English.

° E-mail HP support.
° Find HP support worldwide telephone numbers.

° Locate an HP service center.

Resolving issues

The following sections describe several common issues and solutions.

The computer is unable to start up

If the computer does not turn on when you press the power button, the following suggestions may
help you determine why the computer does not start up:

e If the computer is plugged into an AC outlet, plug another electrical device into the outlet to be
sure that the outlet is providing adequate power.

@’NOTE: Use only the AC adapter provided with the computer or one approved by HP for this
computer.

e If the computer is plugged into an external power source other than an AC outlet, plug the
computer into an AC outlet using the AC adapter. Be sure that the power cord and AC adapter
connections are secure.
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The computer screen is blank

If the screen is blank but you have not turned off the computer, one or more of these settings may be
the cause:

e The computer may be in the Sleep state. To exit Sleep, briefly press the power button. Sleep is
an energy-saving feature that turns off the display. Sleep can be initiated by the system while the
computer is on but is not in use, or when the computer has reached a low battery level. To
change these and other power settings, right-click the Battery icon on the Windows desktop in
the notification area, at the far right of the taskbar, and then click Preferences.

e  The computer may not be set to display the image on the computer screen. To transfer the
image to the computer screen, press fn+f4. On most models, when an optional external display,
such as a monitor, is connected to the computer, the image can be displayed on the computer
screen or the external display, or on both devices simultaneously. When you press fn+f4
repeatedly, the image alternates among the computer display, one or more external displays,
and simultaneous display on all devices.

Software is functioning abnormally

If the software is unresponsive or responds abnormally, restart the computer by pointing to the right
side of the screen. When the charms display, click Settings. Click the Power icon, and then click
Shut down. If you cannot restart the computer using this procedure, see the next section, The
computer is on but not responding on page 92.

The computer is on but not responding

If the computer is turned on but is not responding to software or keyboard commands, try the
following emergency shutdown procedures, in the sequence provided, until shutdown occurs:

/\ CAUTION: Emergency shutdown procedures result in the loss of unsaved information.

e Press and hold the power button for at least 5 seconds.

e Disconnect the computer from external power and remove the battery.

The computer is unusually warm

It is normal for the computer to feel warm to the touch while it is in use. But if the computer feels
unusually warm, it may be overheating because a vent is blocked.

If you suspect that the computer is overheating, allow the computer to cool to room temperature. Be
sure to keep all vents free from obstructions while you are using the computer.

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).

@NOTE: The fan in the computer starts up automatically to cool internal components and prevent
overheating. It is normal for the internal fan to cycle on and off during operation.
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An external device is not working
Follow these suggestions if an external device does not function as expected:
e Turn on the device according to the manufacturer's instructions.
e Be sure that all device connections are secure.
e  Be sure that the device is receiving electrical power.
e  Be sure that the device, especially if it is older, is compatible with the operating system.

e Be sure that the correct drivers are installed and updated.

The wireless network connection is not working
If a wireless network connection is not working as expected, follow these suggestions:

e To enable or disable a wireless or wired network device, right-click the Network Connection
icon on the Windows desktop in the notification area, at the far right of the taskbar. To enable
devices, select the check box from the menu option. To disable the device, clear the check box.

e Be sure that the wireless device is turned on.
e Be sure that the computer wireless antennas are free from obstructions.

e Be sure that the cable or DSL modem and its power cord are properly connected and that the
lights are on.

e Be sure that the wireless router or access point is properly connected to its power adapter and to
the cable or DSL modem, and that the lights are on.

e Disconnect and then reconnect all cables, and turn the power off and then back on.
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C Electrostatic discharge

Electrostatic discharge is the release of static electricity when two objects come into contact—for
example, the shock you receive when you walk across the carpet and touch a metal door knob.

A discharge of static electricity from fingers or other electrostatic conductors may damage electronic
components. To prevent damage to the computer, damage to a drive, or loss of information, observe
these precautions:

If removal or installation instructions direct you to unplug the computer, unplug it after being
properly grounded and before removing a cover.

Keep components in their electrostatic-safe containers until you are ready to install them.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
Use nonmagnetic tools.

Before handling components, discharge static electricity by touching an unpainted metal surface
of the component.

If you remove a component, place it in an electrostatic-safe container.

If you need more information about static electricity or assistance with component removal or
installation, contact HP support.
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power-saving states 35
Product Key 86
product name and number,
computer 86
public WLAN connection 17

R
readable media 35
recovery 75
recovery partition 74
recycle
computer 76
refresh 75
regulatory information
regulatory label 86
wireless certification labels 86
remove everything and reinstall
Windows 76
reset
computer 76
steps 76
restoring the hard drive 74
RJ-45 (network) jack, identifying
9

S

screen brightness keys 26

screen image, switching 26

scrolling TouchPad gesture 22

security cable slot, identifying 10

security, wireless 16

serial number 86

serial number, computer 86

service door 12

service door release latch 13

setting password protection on
wakeup 36

setting power options 35
setup of WLAN 16
setup utility
navigating and selecting 78
restoring factory settings 79
shutdown 34

Sleep
exiting 35
initiating 35
slots
security cable 10
smart card
defined 44
inserting 45

removing 45
SoftPags, downloading 71
software

antivirus 64

critical updates 65

Disk Cleanup 55

Disk Defragmenter 55

firewall 64
speakers, identifying 6
storing a battery 40
switch, power 34

-
temperature 40
testing an AC adapter 42
TouchPad
buttons 4
using 19
TouchPad gestures
pinching 22
scrolling 22
zooming 22
TouchPad zone
identifying 4
traveling with the computer 40,
86, 89
turning off the computer 34

u
unresponsive system 34
USB 3.0 port 9
USB cable, connecting 46
USB devices
connecting 46
description 45
removing 46

USB hubs 45
USB legacy support 78
USB ports, identifying 9, 10
user password 59
using
external AC power 41
power-saving states 35

\"
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VGA port, connecting 31

video 31
volume
adjusting 30
buttons 30
keys 30
volume keys, identifying 26
w
webcam 11, 31

webcam light, identifying 11
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Windows
Refresh 75
reinstall 76
remove everything and reinstall
option 76
reset 76
Windows 8 operating system
DVvD 75
Windows logo key, identifying 7
wireless antennas, identifying 11
wireless button 14
wireless certification label 86
wireless controls
button 14
operating system 14
wireless light 5, 14
wireless network (WLAN)
connecting 17
corporate WLAN connection
17
equipment needed 16
functional range 17
public WLAN connection 17
security 16
using 15
WLAN antennas, identifying 11
WLAN device 15, 86
WLAN label 86
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writable media 35
WWAN antennas, identifying 11
WWAN device 14

V4
zooming TouchPad gesture 22
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